X-123 Quick Start Guide Rev D0

X-123 QUICK START GUIDE (FWo6)
For X-123 units with SDD, Si-PIN, or CdTe detectors

Equipment List for an Amptek X-123 system

* X-123 X-Ray Spectrometer
e Mini USB cable

o +5 VDC power supply
Amptek Installation CD

* A PC with Internet access supplied by the user with Windows XP PRO SP3 or higher recommended

For help using the software please see the Help File in the DPPMCA software. Go to the Help menu and select
Help Topics or press F1 on the keyboard. The Help File contains quick start guides and “how to™ instructions for
many common tasks.

Software Installation

1. Install the WINUSB Driver. Please see the “WINUSB Driver Installation Instructions™ for this procedure. It is
highly recommended to use Windows Update to install the USB driver.

2. Install the DPPMCA display and acquisition software. Locate the directory called “DPPMCA™ on the Amptek
Installation CD and copy the entire directory onto your computer. In that directory is the “DPPMCA .exe” file.
Open this file to start the software. You can right-click on the DPPMCA .exe file and create a shortcut which
can be placed on your desktop for easy access.

X-123 Connection Instructions

I. Verify that the X-123 is completely unplugged (both USB and power).

2. Use the USB cable to connect the X-123 USB connector, which is located on the back panel, to the PC's USB
connector.
3. Plug the DC power supply into a 110/220 AC outlet. Connect the other end to the X-123 power supply input.

which is labeled *5V™ and is located on the back panel.

NOTE: Grounding is critical to obtaining the best performance. We strongly recommend using a single point
ground for the system. To ensure this, use a 3-prong to 2-prong adapter on the power supply of any
notebook computer. This prevents the notebook from introducing another ground into the system.
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Figure 1. Connection Diagram. The detector can be SDD, Si-PIN, or CdTe.
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Quick Use of the X-123
1. Connect the X-123 and PC as described in the previous section.

* The X-123 stores its configuration, so when powering the system initially, the factory configuration is
loaded. If you modify the configuration, the last configuration is loaded.

2. Launch the DPPMCA software by opening the DPPMCA .exe file.
. Connect to the X-123

a. The connection dialog will appear when DPPMCA is launched.
b. Select which interface you will use (USB, Ethernet, or RS232).

il

¢. If more than one device is available, select the device you want.
d. Click "connect.”
4. Configure the X-123
a. The most commonly changed parameters are the gain and the thresholds.
* To quickly change the gain. use the gain increment (decrement) buttons on the toolbar.

* After changing the gain, remove all excitation sources, start an acquisition, then click the "Tune Slow/Fast
Thresholds" button on the toolbar.

o Rtk Dpphica  Coltpblic SoperaliD FET31 PXS Desonight, AL GR1L tea

M Wer | FICR Dty

BEHSRE B0 %k WO D gilcam 2w ol g e )
Hi i
b. For all configuration parameters, click *® , or press F9, or go to the DPP menu and select DPP Setup. Once
you have changed a parameter, click the "Apply" button to send it to the X-123.
¢. Within the DPP Setup dialog box, you can load a default configuration file for your detector or YOl can save
and lead custom configurations.

d. Configuration Tips

e B H

* Changing the gain changes the full scale energy range. For example, a gain of 100 may correspond to a
full scale energy of 15 keV. while a gain of 50 will have 30 keV full scale.

* It is necessary to readjust thresholds (click the tune slow/fast button) whenever the gain is changed and
suggested when any parameter is changed.

* You may want to first take a spectrum and measure the energy range. to verify functionality and to
determine the needed gain.
5. Acquire data
a. Place a source in front of the detector.
b. To start or stop acquisition, click the "start/stop" icon in the toolbar or press the space bar.

¢. To clear the data and time, click the “delete data and reset time" button in the toolbar or press "A" on the
keyboard.
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d. Data Acquisition Tips
* It can take minutes for an Amptek detector to stabilize after power has been applied or a configuration
changed. If the spectrum looks odd. clear the data and restart.
* You can tell that data are being acquired if (a) the spectrum appears in the window, (b) the input and total
counts are increasing, (c) the accumulation time is increasing, and (d) the "status" in the right hand Info
Panel reads "acquiring."
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* You can set the X-123_to stop acquisition after a fixed time, after a fixed number of counts are collected.
and with other options using the MCA tab on DPP setup.
6. Display data
a. The spectrum, counts, and accumulation time are automatically displayed as data are acquired. If a region of
interest is defined and selected. its net area and other properties are also shown.

b. To zoom in on a portion of the spectrum, use the arrows at lower right. To return to the full screen view, use
the full range arrows on the toolbar.

¢. To toggle between a linear and a logarithmic vertical scale click on the spectrum and press "L" on the
keyboard or select the scale from the Display menu.
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d. The primary data from the X-123 are the spectrum and the count rates. There are auxiliary outputs on the X-
123. These are useful for interfacing the X-123 with other hardware. They are described in the X-123 user
manuals.

7. Analyze data
a. Regions of Interest

* A Region of Interest (ROI) is an area marked as a potential peak in a spectrum.

* DPPMCA supports several ways to mark or define an ROI. The easiest way is to place the cursor at the
left edge (lowest channel) of desired region and then press and hold the "U" key until the peak is
highlighted and the upper edge is reached. You can also click on the Mark ROI button on the toolbar and
then click and drag the cursor over the peak.

* For each ROI, DPPMCA computes the total counts (gross area). subtracts the background, and for the
difference computes the net area, centroid. and peak width. The resolution is also displayed.

b. Energy calibration
The native scale (x-axis) of the hardware is channels. Most often you will want to convert the channel scale
to energy.
1. Chose the two peaks that will be used for the calibration and make note of their energies.
2. Mark an ROI (region of interest) around each peak. This can be done by clicking the cursor at the left
base of the first peak and then holding down the “U” key on the keyboard until the whole peak is
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highlighted, or by using the Edit ROl button on the toolbar and then clicking and dragging across the
peak until it is highlighted.

lud

. Now click in the toolbar button “Calibrate™ (F5) to open the calibration dialog box.

4. Move the dialog box such that both peaks are visible and then click the cursor into the first peak. The
peak should be highlighted and the Peak Information section on the right-hand information panel should
be filled in. If the peak is highlighted and there is no peak information, then the ROI is not marked
correctly. Try adjusting the start and end points of the ROL

5. Click the Centroid button on the dialog box. This will enter the center position of the peak into the
Channel box. Then enter the energy of that peak into the Value box, e.g. 6.4, and click Add.

6. Now click the cursor into the second peak (it will highlight). Click on Centroid. enter the second energy,
e.g. 17.48. and click Add. There should now be two lines in the box.

7. In the Units box type in the energy units, e.g. keV.

8. Click OK. The scale should now be in energy. If it is not press F7, this toggles between calibrated units

and channels.
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8. Save and load data
a. To save a data file, click the "File Save" icon or select Save As from the File menu. Data are saved in an
ASCII file format with a .mca extension which includes the counts in each channel. slow and fast counts, ROI
and calibration data, and the DPP configuration parameters. This file can be opened in notepad. Excel, etc.
b. To load a saved data file use the "File Open" icon. The ROI and Calibration data from a stored file can be
transferred to a spectrum being analyzed or can be automatically loaded when you open DPPMCA (View
menu -> Preferences-> General Tab).

F}

To process the data using a different software package the .mca file can be opened as a text file. Alternately.
you can click "Ctrl-R" to copy the data to the Clipboard, then paste it where desired, e.g. in Excel.
d. To print a spectrum press "Ctrl-P" or the "Print" icon on the toolbar.
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Troubleshooting the DPPMCA Software

If you cannot connect to the X-123 check the following:
e Was the software correctly installed?
e Were the drivers properly installed?
e Arcall the cables connected?
o Isthe X-123 power plugged in?
If you start an acquisition but see no counts:
e [sthere an isotopic source in front of the detector or is the X-ray tube turned on?
o [s the DPP configured properly?
o Amptek provides a set of default configuration files. [f you are having problems, we recommend

loading one of these defaults. It may not be optimum for your experiment but should get you started.
Open the DPP Properties->General tab and select a configuration from the drop-down.

Does the polarity of the HV bias set in software match that set in hardware?
Amptek SDD detectors require NEGATIVE HV.
o Amptek Si-PIN and CdTe detector require POSITIVE HV.

& Check the info pane to see if the HV is enabled (if not. the reported value will be a few volts) and
check the polarity. The HV is set and enabled on the Power tab of the DPP Properties.

Are the input polarity and offset correct?
¢ Pulses of the wrong polarity or with an incorrect input offset will be outside the range of the ADC and
therefore not measured. Verify the input polarity and set the input offset to “default.”
o Amptek SDD detectors require POSITIVE input polarity.
o Amptek Si-PIN and CdTe detector require NEGATIVE input polarity.
Are pulse selection settings rejecting everything?

* The pile-up rejection and rise-time discrimination circuits will reject from the spectrum events which do
not meet certain criteria (discussed in the manuals). If the system is configured incorrectly, it is quite
common for no pulses to be recorded. Turm off PUR and tumm off RTD while you are setting up and
debugging the system. Most systems will work best with PUR enabled. once everything else is configured
properly. RTD is an advanced setting and we recommend most users leave it disabled.

Are the thresholds correet?

o Always click the Tune Slow/fast thresholds button on the toolbar (with no source in front of the detector).
This automatically sets the slow (LLD) and fast thresholds. It is recommended to click the tune slow/fast
thresholds button whenever you change a setting.

e The Fast and Slow Thresholds can also be adjusted manually. First turn off PUR as described above. Then
click the cursor to channel 1 and press F8. This will set the Slow Threshold (LLD) to channel 1. This will
show the noise of the system. Click the cursor just to the right of the noise and then press F8. Press the
“A” key to clear. There should be no counts accumulating. Now put the device into “Delta™ mode (only
one second’s worth of data is displayed every second) by clicking the Delta button on the toolbar. Open
the DPP properties and go to the Shaping page. Adjust the Fast Threshold until 5 to 10 counts per second
appear in the Input Counts in the right-hand Info Panel. Now turn on PUR and click OK. Click the Delta
button to get back to normal MCA mode and put the source back in front of the detector. The Input Counts
should slightly exceed the Total Counts at low count rates. The Total Counts should always be less than
the Input Counts. If they are not. then thresholds are not set correctly.

If you still do not see a spectrum or the correct spectrum, save a .mca file from the File menu and email it to

sales(@amptek.com. This file contains important information that will help Amptek troubleshoot the problem. Do
not send sereen shots or any other type of file. Only the .mca file is needed.
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Firmware Notes
How can [ tell if my DP3 or X-123 with a DPS has FWS or FW6?

If your unit was shipped before November 15, 2011 it has FWS5. [f was shipped on or after November 15, 2011 it
has FWe6.

If vour unit connects to the ADMCA application software it has FW5. If it conneets to the DPPMCA application
software it has FW6.

Do I have to rewrite custom software that I developed for FWS to support FW6?

Yes. FW6 is NOT backwards compatible with FW3. It uses a new protocol. You must implement the Software
Developer’s Kit (SDK). The old DPP APl is NOT compatible with FW6.

FW6 SDK: http://www.amptek.com/dp5_sdk.zip
Which firmware version will be supported by Amptek going forward?

Only FW6 will be supported going forward. There will be no future upgrades or bug fixes to FW5. All new
functionality will be incorporated only into FW6. Amptek strongly recommends that users of FW3 migrate to the
FW6 platform as soon as possible. For this reason Amptek supplies a firmware uploader so that you can easily go
back and forth between the firmware versions. This will allow you to develop new software on your own timetable.

Firmware Loader: hitp://www_amptek.com/uploader.zip

FW4 (legacy)* FW5 FW6
X-123 (with DP5) Optionaluserdowngrade | Default from the factory
DPS Optional user downgrade | Default from the factory
PX5 X
Gamma-Rad5s X
DPP
Hardware L X
PX4 X
DP4 X
X-123 (with DP4) X
Gamma-Rad X
Application | ADMCA X X
Software | DPPMCA X
XP 32 bit Auto Auto Auto
Windows | XP 64 bit Manual Manual Auto
Update E
USB Driver Vista 32 bit Manual Manual Auto
& Vista 64 bit Manual Manual Auto
Operating :
System Win 7 32 bit Auto Auto Auto
Win 7 64 bit Auto Auto Auto

*FW4 Legacy devices must be upgraded in order to use the WINUSB driver and Windows Update. See the
“Windows 7 Compatibility” document.

Windows 7 Compatibility Document: htp://www.amptek.com/pdf/winTupgrade.pdf
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X-1238D0 S/N: X015519, AXRSDD S/N: 173450, PC5 S/N: 1908110335, DPS SMN: D18130

Window Thick - Ba 0.5mil, T Sensor - Diode, Coli = Internal Multilayer,

Cooler Stage - 2 stage, Detector Thickness - 500um, Detector Ares - 25mmz, Detactor Typa - Silican,

Fendback Type - Drift, y Type - 1.5 inch EXT, SOD

T=214.0 Degrees K, FWHM@S.885keV: 126V, Tostod with 11.2u5 Peak Titne, HV Bias; -135.0 Vois,

Amptek Code # ZY-GSJIAMD-GI5P

Configuration

P — RESC=?7; Reset Configuration
CLCK=80; 20MHz/A0MHz TPEA=11.200; Peaking Time
GAIF=0.90T8; Fine Gain GAIN=88.999; Total Gain (Analog * Fine}
RESL=104; Detector Reset Lockout TFLA=0.200; Fiat Top

TPFA=100; Fast Channel Peaking Time PURE=ON; PUR Interval On/Off
RTDE=OFF; RTD On/GHt MCAS=NORM; MCA Source
MCAC=1024; MCA/MCS Channels SOFF=0FF; Set Spectrum Offset
AINP=POS; Analog input Pos/Neg INOF=DEF; Input Offsat

GAIA=22; Analog Gain Index CUSP=0; Non-Trapezoidal Shaping
POMD=NORM; Peak Detect Mode [Min/Max) THEL=0.781; Slow Threshold
TLLD=OFF; LLD Threshold THFA=20,08; Fast Threshold
DACO=SHAPED; DAC Output DACF=30; DAC Offsat

RTYDS=0.0; RTD Sensilivity RTDT=0.00; RTD Threshold

BLAM=1; BLR Mode BLRD=3; BLR Down Correction
BLRU=0; BLR Up Correction GATE=OFF; Gate Control

AUO1I=SCAB; AUX_OUT Selection PRET=0FF; Prosat Time

PRER=0FF, Prset Real Time PREC=OFF; Presst Counts

PRCL=1; Preset Counts Low Thrashold PRCH=3191; Preset Counts High Thresheld
HVSE=-115; HVSet TECS=150; TEC Set

PAPS=ON; Proamp 8.5/5 (MA) SCOE=FA; Scope Trigger Edge
SCOT=12; Scope Trigger Pasition SCOG=1; Digital Scope Gain

MCSL=1; MCS Low Threshold MCSH=8181; MCS High Threshoid
MCST=0.01; MCS Timabase AUO2=ICR; AUX_DUTZ Salection
TPMO=0OFF; Test Pulser On/Off GPED=RI; G.P.Counter Edge
GPIN=AUX1; G.P. Counter Input GPME=ON; G.P.Counter Uses MCA_EN7
GPGA=ON; G.P. Counter Uses GATE? GPMC=0ON; G.P.Countsr Cloared With MCA Counters?

MCAE=OFF: MCA/MCS Enabile BOOT=0N; Tum Supplies On/ONf At Power Up




